
 

Virtual TimeClock® Network Edition Setup Guide


This guide will orient you with Virtual TimeClock and walk you through the essential setup required for a 
new user of Virtual TimeClock Network Edition. For installation follow the steps on our installation guide 
beginning with installing the Virtual TimeClock Server Manager. If you are moving your TimeClock  or 
upgrading your software, review the moving guide or the upgrading guide.


A Pro Client is required for the setup of the time clock because it has administrative access, whereas a 
User Client only allows users to clock in. Note: the Server Manager does not interface with the 
TimeClock. If you have not yet purchased Virtual TimeClock, the software will run for a limited time as a 
fully-functional Free Trial.


Topics discussed in this Setup Guide:


A.  Add Users

1. Once you’ve connected a Pro Client to your TimeClock Server, you will need to add users to the 

time clock. Users can be added manually or imported from a .CSV or QuickBooks .IIF file. If you 
choose to add users manually, follow the steps below.


2. Select Add Users and a window will open. After entering each user click Save & Next to 
continue adding users. When done click Save & Close.


3. After adding users you will be brought to the Configure Users window. To edit a user’s 
information, select the user name in the left column and use the Access, Employment and Notes 
tabs. For information, review the Overview of Users, Managers & Administrators article.


• In the Access tab you can set passwords and change a user’s status.


• The Employment tab contains information such as hire dates, wages, and more.


• The Notes tab allows you to input and record any other user information. 


A. Add Users	 1

B. Display Groups	 2

C. Important Notes for Display Groups	 3

D. Assigning Managers & Administrators	 3

E. Breaks & Lunches	 4

F. Activities	 5

G. Overtime Settings	 5

H. Payroll Settings	 6

I. Time Settings	 6

J. Security Rules	 7

K. Licensing	 7

L. Administration and User Mode	 7

M. Schedule Backups	 8

www.redcort.com	 	 23.1. 12/1/231

https://www.redcort.com/virtual-timeclock-knowledge-base/install/network/install-network
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4.    To add more users click Add in the bottom left corner of the Configure Users window. To return 
	    to this window in the future, click Users from the Configure menu.





B. Display Groups

To continue with the setup of your time clock click the Groups icon in the toolbar of the Configure Users 
window to edit Display Group settings. Display Groups are how rules are assigned to specific groups of 
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Caution: Deleting a user 
permanently removes the 
user and all their timecard 
information from the 
program. Instead of 
deleting, consider making a 
user inactive.


Use the popupmenu at the 
top of the User list to filter 
which users are displayed.


1. With the Settings tab selected, 
choose the group interface users 
will clock in on. 


• For detailed information, 
review this article.


2. Decide if users will use a password. 


• If using the In/Out Board, 
users will be prompted to 
create a password the first 
time they clock in. Otherwise 
passwords need to be 
assigned to users in the 
Configure Users window.


3. Review the default settings by 
going though each of the tabs in 
this window and orient yourself to 
the settings of Virtual TimeClock. 
We recommend that after you 
familiarize yourself with the 
program to revisit these settings.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/users-managers-administrators/deleting-and-inactivating-users
https://www.redcort.com/virtual-timeclock-knowledge-base/features/users-managers-administrators/deleting-and-inactivating-users
https://www.redcort.com/virtual-timeclock-knowledge-base/features/display-groups/overview-of-display-groups
https://www.redcort.com/virtual-timeclock-knowledge-base/features/users-managers-administrators/deleting-and-inactivating-users
https://www.redcort.com/virtual-timeclock-knowledge-base/features/users-managers-administrators/deleting-and-inactivating-users
https://www.redcort.com/virtual-timeclock-knowledge-base/features/display-groups/time-clock-interface-options
http://www.redcort.com
https://www.redcort.com/virtual-timeclock-knowledge-base/features/display-groups/time-clock-interface-options


 

users. Display groups can be used to track and display users of different locations to simplify the 
clocking in process for users and for those managing the TimeClock.


Below are examples of the interfaces options available in Virtual TimeClock.


C. Important Notes for Display Groups

• To save time and for anonymity, many companies use the PIN or Passcode interface for 

employees to quickly login without seeing other users. The In/Out Board can be customized 
for privacy by unchecking Time and Elapsed within the In & Out Board Options section, so 
users do not see the time other users clocked in.


• Group passwords are optional and are for users to enter if the TimeClock becomes 
disconnected from the Virtual TimeClock Server Manager. Entering the password in the Login 
to Server window will open the TimeClock to User mode and interface assigned to the display 
group. This password is not used to clock someone in or out, only to reconnect the TimeClock.


D. Assigning Managers & Administrators

Managers and Administrators in Virtual TimeClock are Users who are assigned permissions that allow 
them to access features like viewing reports and editing entries. A Manager can have limited access to 
settings and features, but an Administrator has full access to everything. 


Managers must be assigned to a Display Group to access user reports and edit entries. Users and 
managers can be assigned to multiple groups if necessary, but Administrators have access to 
everything by default. Assign a user to be a manager of a group by going to the Managers tab of the 
Display Groups window. In the Group Managers section click Select and choose which users to give 
manager access to. To come back to this window later, go to Configure > Display Groups and select 
the Managers Tab. 


Managers and Administrators can turn administration mode on from the File menu using their name 
and password. However, unlike an Administrator, Managers will only see the Display Group, reports 
and features that the Administrator granted them permission to see. 
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PIN Interface

In & Out Board Interface 
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To continue setup click Show All in the Toolbar. While in administration mode you can revisit this 
window by clicking the Configure gear icon in the toolbar on the In & Out Board. The different 
configuration categories are organized in the sections People, Groups, System, and Data.


E. Breaks & Lunches

With the Configure window open, within the Groups Section select the Breaks & Lunches icon. You 
can track paid and unpaid breaks and lunches.	 


1. From the Configure Breaks & Lunches window select if breaks & lunches are paid, unpaid or 
paid with a limit of time.	 


2. Break and Lunch buttons are visible to users by default. The buttons can be removed by going 
to Configure > Display Groups and uncheck the boxes under the Breaks & Lunches section.
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• Restrict early or late return 
from lunch by setting shift 
rules in the Shifts 
settings.

• Go to Configure, then 
Auto Add/Deduct Time if 
you want to track lunch, 
but not have employees 
clock out for lunch.

http://www.redcort.com


 

F. Activities

The time clock can track time spent on different tasks, jobs, or projects, to setup click the Configure 
program menu and choose Activities, which is found in the Groups section. When users clock in they 
will select an activity. If you want to track time by projects or activities throughout the day instruct your 
employees to choose the correct activity when they clock in. Users can change activities as often as 
needed during a shift to track their time for tasks and billable projects.To learn more about activities, 
review the Overview of Activity Tracking Knowledge Base article on our website.


G. Overtime Settings

To configure and assign overtime rules to users, select Overtime within the People section of the 
Configure window. To learn more creating an overtime rule and how hours are calculating, review the 
Overview of Overtime Knowledge Base article on our website.
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Important Note: Users can only be 
assigned to one overtime rule. 
Confirm you are assigning users to 
the correct rule. 

1. There are three built in Overtime Rules you 
can choose from or add your own. Click to 
select the overtime rule you wish to edit or 
click Add to create a new one.


2. Edit the rule by clicking Modify Rule to set 
thresholds and rates.


3. Assign the overtime rule to users by clicking 
Edit. If users are not assigned, the overtime 
rule will not be applied to them.

You can view reports based on 
activities by clicking the Reports 
program menu and choose 
Activity Detail to get started.

1. Click the Add button to create 
a new activity. 


2. If you want users to be able to 
select the activity when 
clocking in then set the status 
to TimeClock and Manual 
Entries. 


3. Determine if activities are 
paid, unpaid or paid with a 
limit of time.


4. To assign activities to specific 
groups of users, click Edit 
Group Activities.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/tracking-hours/reporting-activities
https://www.redcort.com/virtual-timeclock-knowledge-base/features/tracking-hours/reporting-activities
https://www.redcort.com/virtual-timeclock-knowledge-base/features/tracking-hours/reporting-activities
https://www.redcort.com/virtual-timeclock-knowledge-base/features/tracking-hours/reporting-activities
http://www.redcort.com
https://www.redcort.com/virtual-timeclock-knowledge-base/features/tracking-hours/activity-tracking-overview
https://www.redcort.com/virtual-timeclock-knowledge-base/features/overtime/overview-of-overtime


 

H. Payroll Settings

Payroll Settings allows you to adjust the Payroll Frequency, Period, Timecard Approval, and Payroll 
Export. To configure, select Payroll Settings within the System section of the Configure window.


I. Time Settings

To configure how hours are rounded and displayed on timecards select Time Settings within the 
System section of the Configure window.
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With quarter hour rounding, 8:07 would round down to 8:00 and 8:08 would round up to 8:15.

1. Choose your timestamp source. If 
tampering with the computer’s 
clock is a concern, choose an 
Internet Time Server as the 
timestamp source.  If you have 
time clocks across time zones, 
select Internet Time Server to 
record local time of time clock 
entries.


2. Set your workweek start day. This 
does not affect your payroll 
period. It will effect how your 
weekly totals are displayed on 
reports.


3. Select the time rounding setting. 
This is based on how time totals 
will be displayed. This will not 
change the recorded start and 
stop times, only how the hours 
are calculated. Find out more.

1. Set payroll frequency from the drop 
down menu.


2. Enter current payroll period start date. 
The system will autofill the end date by 
the payroll frequency selected, unless it 
is User Defined. 


3. If you plan on using payroll integration, 
ensure the TimeClock is compatible 
with your payroll company. Click here to 
find out if Virtual TimeClock imports into 
your program and follow the one-time 
setup guide for your payroll provider. 


4. After setting up payroll integration with 
your provider, return to the Payroll 
Settings window. Select the company 
from the list and click Setup to 
complete the set up process.

https://www.redcort.com/virtual-timeclock-knowledge-base/features/time-calculations/timestamp-source
https://www.redcort.com/virtual-timeclock-knowledge-base/features/time-calculations/time-rounding
https://www.redcort.com/timeclock/timeclock-payroll-integration
https://www.redcort.com/timeclock/timeclock-payroll-integration
http://www.redcort.com
https://www.redcort.com/virtual-timeclock-knowledge-base/features/time-calculations/timestamp-source
https://www.redcort.com/virtual-timeclock-knowledge-base/features/time-calculations/time-rounding


 

J. Security Rules

We recommend password protecting administrative features of the TimeClock. You can also set user 
password rules by clicking Security in the System section of the Configure window.


1. Requiring a password to turn on Administration is enabled by default. If you do not want to 
require a password, click to uncheck the box labeled and click Apply.


2. Set and review password rules for users based on your organization’s needs.


• To discourage buddy punching, we recommend setting the password to the user’s Social 
Security Number. We find users are less likely to share their SSN with others.


K. Licensing

After a Virtual TimeClock license is purchased, an email containing the license key and instructions will 
be sent. The software will continue to run in eval mode until a valid license key is entered. 


L. Administration and User Mode

There are two modes of the time clock. One is Administration Mode, which you must be in to make 
changes to settings and where Managers and Administrators can edit entries and access reports. 

To turn Administration Mode on and off, go to File then Turn Administration On/Off. You will be 
prompted to enter your administrator or manager password.


If you’re logged into Administration Mode, 
the toolbar of icons and functions are 
visible as well as the Configure settings. 
Popular TimeClock functions can be 
accessed directly from the program menu 
bar.

To change the users displayed on the In & 
Out Board change the Display Group by 
choosing a different group from the drop 
down menu in the bottom right-hand corner. 
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Always Turn Administration Off before leaving the computer unattended 
and allowing users to clock in/out.


This is User Mode when the 
In/Out Board interface is 
chosen for this Display Group.


Need to show employees how 
to use the time clock? Print 
the User Quick Reference 
from the Help menu.


https://www.redcort.com/virtual-timeclock-knowledge-base/features/passwords-and-security/overview-passwords-security
https://www.redcort.com/files/pdfs/vtc-pro-docs/Virtual-TimeClock-Pro-Users-Guide-Windows.pdf
http://www.redcort.com
https://www.redcort.com/files/pdfs/vtc-pro-docs/Virtual-TimeClock-Pro-Users-Guide-Windows.pdf


 

M. Schedule Backups

To schedule a regular TimeClock database backup, open the Virtual TimeClock Server Manager 
program and click the Backup icon in the toolbar. Here you can set the backup schedule or do a 
manual backup by clicking Backup Now. Click to learn more about backups in Virtual TimeClock. 








Congratulations! Virtual TimeClock is now setup and ready to use!




Copyright 1986-2023 Redcort Software Inc. All Rights Reserved. Virtual TimeClock and Virtual TimeClock Pro are registered trademarks of Redcort 
Software Inc. All other names mentioned are trademarks or registered trademarks of their respective holders in the United States and other countries.

www.redcort.com	 	 23.1. 12/1/238

Need more help with the topics covered in this guide? Check out the Administrator Quick 
Reference found in the Help menu of the Server Manager and any time clock Client.

Important:

Don’t store backup files 
on the same computer as 
your TimeClock. If your 
computer crashes, the 
backups will be lost as 
well. Always backup to an 
external drive or folder.
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